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கற்றலின் ந�ோக்கங்கள்

இந்த பாடத்தைக் கற்றபின் மாணவர்கள் அறிந்து 

க�ொள்பவை

•	 இயக்க அமைப்பின் கருத்துருக்களைத் 

தெ  ரி ந் து க �ொ  ள் ளு த ல் .

•	 விண்டோஸ் இயக்க அமைப்பின் பதிப்புகளை 

அறிந்து க�ொள்ளுதல். 

•	 முகப்புத்திரை மற்றும் சன்னல் திரையின் 

கூறுகளின் கருத்துருக்களைத் அறிந்து 

க �ொ  ள் ளு த ல் .

•	 ஆவண சன்னல் திரையை ஆராய்தல்

•	 பல்வேறு வகையான பணிக்குறிகளை 

ஒ ப் பி டு த ல் .

•	 விண்டோஸ் க�ோப்புறை அடைவு அமைப்பை  

ஆராய்தல்.

•	 ஒரு குறிப்பிட்ட இயக்கவட்டில் 

க�ோப்புகளையும், க�ோப்புறைகளையும், 

உருவாக்குவதற்கான பயிற்சி.

•	 க�ோப்புகளையும், க�ோப்புறைகளையும் 

நி ர ்வ கி த ்த ல் .

•	 முறைப்படி ஒரு கணிப்பொறியின் 

இயக்கத்தைத் த�ொடங்குதல் மற்றும் நிறைவு 

செ  ய ்த ல் .

5.1. இயக்க அமைப்பு ஓர் அறிமுகம் 
	 இயக்க அமைப்பு (Operating  System) 
ஒரு அமைப்பு மென்பொருள் (System Software) 
ஆகும். இது வன்பொருட்களை, மற்ற 

பகுதி 1 – விண்டோஸ் - ல் வேலை செய்தல்
ப�ொதுவான இயக்க அமைப்பில் வேலை செய்தல்

பாடம் 5கணினியின் அடிப்படைகள்

மென்பொருட்களுடன் த�ொடர்பு க�ொள்ளவும், 

இயக்கவும் வகை செய்கிறது. மேலும், 

பயனரையும், வன்பொருட்களையும் இணைக்கும் 

இடைமுகமாகவும், கணிப்பொறியின் 

அனைத்து இயக்கங்களைக் கட்டுப்படுத்தவும் 

பயன்படுகிறது. (படம் 5.1)
1 பயனர் 2 பயனர் n பயனர்

மென்பொருள்

அமைப்பு 
மென்பொருள்

பயன்பாட்டு
மென்பொருள்

இயக்க அமைப்பு

வன்பொருள் மைய செ-
யலகம் நினைவகம்

உள்ளீடு /
வெளியீடு

படம் 5.1 இயக்க அமைப்பு ஒரு பார்வை

	 முந்தைய பாடத்தில் கற்ற, இயக்க 

அமைப்பின் சில முக்கிய செயல்பாடுகள் பின் 

வ ரு ம ா று :

•	 நினைவக மேலாண்மை

•	 செயல் மேலாண்மை

•	 சாதன மேலாண்மை 

•	 க�ோப்பு மேலாண்மை 

•	 பாதுகாப்பு மேலாண்மை

•	 கணிப்பொறி செயல்பாடுகளின் மீதான 

ஒட்டும�ொத்த கட்டுப்பாடு

•	 பிழை கண்டறியும் சாதனம்

•	 பயனருக்கும் இதர மென்பொருள்களுக்கும் 

இடைேயயான ஒருங்கிணைப்பு.

அலகு I 
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5.2. விணநடோஸ் இயகக அ்மப்பு ஓர 
அறிமுகம்

 ஒவ்கவோரு  கணிப்கபோறியும் 

இயஙகுவ்தறகு ஏந்தனும் ஒரு இயகக 

அ்மப்பு ந்த்வப்படுகி்றது. அந்த வ்கயில், 

்மகநைோசோப்ட விணநடோஸ் மிகவும் பிைபைமோ்ன 

ஒரு “வ்ைக்ை பய்னர இ்டமுகம்” (GUI - 
Graphics User Interface) இயகக அ்மப்பு 

ஆகும். விணநடோஸ்-ல் ஒநை ந�ைததில் 

ஒன்றுககும் நமறபடட பயன்போடுக்ை 

இயகக முடியும் இ்தறகு “பல்பணியோககம்” 

(Multitasking)  என்று கபயர.

 விணநடோஸ் இயகக அ்மப்பில், 
வி்சப்பை்க மறறும் சுடடி ஆகிய இைண்டயும் 
உள்ளீடடு சோ்த்னஙகைோகப் பயன்படுத்தைோம். 
சுடடி்ய பணிககுறிகளில் கிளிக கசயவ்தன் 
மூைம்,                 விணநடோஸ்-ல் கூறுகளுடன் எளிதில் 
கசயல்பட முடியும். வி்சப்பை்க, எழுததுககள், 
எணகள் மறறும் சி்றப்பு குறியீடுக்ை உள்ளிடப் 
பயன்படுகி்றது.

விணநடோஸ் இயகக அ்மப்பின் சிை  
க ச ய ல் ப ோ டு க ள்

• கசோறகசயலிகள், அடடவ்ணச் கசயலிகள், 
கணிப்போன், வி்ையோடடுகள் நபோன்்ற  
பயன்போடுக்ை இயககுவ்தறகு.

• கணிப்கபோறியில் புதிய பயன்போடுக்ை 
நி று வு வ ்த ற கு .

• அச்சுப் கபோறி, வருடி, சுடடி, இைகக 
வ்க நகமைோ நபோன்்ற வன்கபோருள்க்ை 
நமைோண்ம கசயவ்தறகு.

• நகோப்பு மறறும் நகோப்பு்்றகள் உருவோககு்தல், 
பதிப்போயவு கசய்தல், நசமித்தல்,  
அழித்தல் நபோன்்ற நகோப்புநமைோண்ம 
கசயல்போடுக்ை கசயவ்தறகு.

• கணிப்கபோறியின் அ்மப்புகைோ்ன 
(Settings), வணண திடடஙகள் (Colour 
Scheme), தி்ைககோப்பு (Screen Savers) 
நபோன்்றவற்்ற தி்ையில்மோறறி அ்மகக.

அடடவ்ண 5.1 ல் விணநடோஸ் 
இயகக அ்மப்பின் பல்நவறு பதிப்புகள் 

ப ட டி ய லி ட ப் ப ட டு ள் ை து .

5.3. வின்நடோஸின் பல்நவறு பதிப்புகள்

பதிப்புகள் சின்்னம் ஆணடு முககிய சி்றப்பியல்புகள்

விணநடோஸ் 1.x

 

1985

(1) 16 பிடடுகளில் வ்ைக்ை பய்னர          இ்டமுகம் 
அறிமுகம் கசயயப்படடது.

(2) சுடடி, உள்ளீடடுச் சோ்த்னமோக அறிமுகம் 
கசயயப்படடது.

விணநடோஸ் 2.x 1987

• சன்்னல் தி்ை்ய சிறி்தோககு்தல், அல்ைது 
கபரி்தோககு்தல் வசதி.  

• ்தனிப் பய்னோககு்தல்  விருப்பத ந்தரவுகள் 
(Customising Options) மறறும் கணிப்கபோறி 
அ்மப்பு (Computer System Setting) 
மோறறு்தல் நபோன்்ற சி்றப்பம்சஙகளுடன் 
”கடடுப்போடடுப் பைகம்” (Control Panel) 
அறிமுகம் கசயயப்படடது.

விணநடோஸ் 3.x 1992

• விணநடோஸ்-ல் “பல்பணி கருததுரு” 
(Concepts of Multitasking) அறிமுகம்.

• 256 வணணஙக்ை ஆ்தரிப்ப்தோல், 
அதி�வீ்ன வணணமயமோ்ன ந்தோற்றத்்த 
இ்டமுகததிறகு அளிககி்றது. 
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விணநடோஸ் 95 1995

• க்தோடகக கபோத்தோன், பணிப்பட்ட, 
விணநடோஸ் எகஸ்ப்நைோைர மறறும் 
க்தோடககப்படடி அறிமுகம்.

• 32 பிட கசயலி அறிமுகம் மறறும்  
பல்பணியோககம் மீது அதிக கவ்னம் 
க ச லு த ்த ப் ப ட ட து .

விணநடோஸ் 98 1998

• இயகக அ்மப்புடன், ஒருஙகி்ணந்த 
இ்ணய உைவி (இணடரக�ட எகஸ்ப்நைோைர 
- Internet Explorer) அறிமுகம்.

• DOS  அடிப்ப்டயிைோ்ன வி்ையோடடுகள்  
ம்்றயத க்தோடஙகி, விணநடோஸ் 
அடிப்ப்டயிைோ்ன வி்ையோடடுகள் 
ந ம ம் ப டு த ்த ப் ப ட ட து .

• கசருகி (Plug and play)  உபநயோகித்தல் 
சி்றப்பம்சம் அறிமுகம்.

விணநடோஸ் NT
• வ்ைய்மப்பில் நச்வயகம் நபோல் 

வ டி வ ் ம க க ப் ப ட ட து .

விணநடோஸ் Me 2000
• ்தோனியஙகு  கணிப்கபோறி 

பரிநசோதித்தல் மறறும் மீடபுக கருவிகள் 
அ றி மு க ப் ப டு த ்த ப் ப ட ட ்ன .

விணநடோஸ் 
2000 2000

• வணிகநம்சக கனிணி மறறும் மடிக 
கனிணிகளில்  இயகக அ்மப்போக 
ந ச ் வ ய ோ ற றி ய து .

• விணநடோஸ் 2000ல் �ோன்கு பதிப்புகள் 
கவளியிடப்படட்ன.

• Professional (வணிக நம்சக கனிணி 
மறறும் மடிககணினிகள்)

• Server (இ்ணய நச்வயகம் மறறும் 
அலுவைக நச்வயகம்).

• Advanced Server (க்தோழில்து்்ற 
ப ய ன் ப ோ ட டி ற க ோ க )

• Data Centre Server (உயர நபோககுவைதது 
(high-traffic) கணிப்கபோறி நச்வயகம்). 

விணநடோஸ் XP 2001
• 64-பிட கசயலிகள் அறிமுகம்.

• வின்நடோஸ் ந்தோற்றம் மறறும் நி்ையோ்ன 
பணித்தைம் நமம்படுத்தப்படடது.
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விணநடோஸ் 
Vista 2006 • விணநடோஸ் ந்தோற்றம் நமம்படுத்தப்படடது.

விணநடோஸ்  7 2009

• கணிப்கபோறியின் க்தோடஙகு்தல் ந�ைம் 
நமம்படுத்தப்படடது.

• ஏநைோ பீக (Aero Peek), பணிப்பட்டயில் 
பயன்போடுக்ை இ்ணத்தல் (pinning 
programs to taskbar), ்ககயழுதது 
உணர்தல் (Handwriting recognition), 
இன்டரக�ட எகஸ்புநைோைர 8 (Internet 
Explorer 8) நபோன்்ற புதிய பய்னர இ்டமுக 
வசதிகள் அறிமுகப்படுத்தப்படடது.

விணநடோஸ் 8 2012

• விணநடோஸ்-ன் முந்்தய பதிப்புக்ை 
விட விணநடோஸ் 8 மிகவும் நவகமோக 
க ச ய ல் ப ட க கூ டி ய து . 

• க்தோடகக கபோத்தோன் நீககப்படடது.

• விணநடோஸ் 8 - யில் "பல் அடுககு கசயலி" 
(Multi Core Processing), திட நி்ை 
இயககிகள், க்தோடுதி்ை மறறும் மோறறு 
உள்ளீடடு மு்்றகள் நபோன்்ற சி்றந்த 
�ன்்மகள் உள்ை்ன.

• ்கப்நபசி மறறும் கணிப்கபோறிகளுககோ்ன 
கபோதுவோ்ன பணிநம்டயோக கசயல்படடது.

விணநடோஸ் 10 2015

• க்தோடகக கபோத்தோன் மீணடும் 
ந ச ர க க ப் ப ட ட து .

• ஒன்றுககும் நமறபடட தி்ை முகப்பு.

• "கசயலி அறிவிப்பு" மறறும் "வி்ைவு 
�டவடிக்க கசயலிககோ்ன மததிய அறிவிப்பு 
்மயம்" அறிமுகம்.

கோரடோ்னோ குைல் கசயலியகக ்தனி உ்தவியோைர வசதி (Cortana voice activated Personal assistant) 

5.4. சுடடி்யக ்கயோளு்தல் 

 விணநடோஸ் இயகக அ்மப்பில் நவ்ை 

கசயவ்தறகு முன்பு சுடடியின் இயககத்்தப் 

பறறி அறிநது ககோள்ை நவணடும்.

வைது கிளிக

இடது கிளிக
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படம் 5.2.சுடடியின் கசயல்போடுகள்

சுடடியின் கசயல்போடுகள்

கசயல் வி்ைவு

ஒரு உருப்படி்ய 
(item) சுடட 

சுடடி்ய ஒரு உருப்படியின் மீது 
�கரதது்தல்.

கிளிக

தி்ையில் உள்ை ஒரு 
உருப்படியின் மீது சுடடி்ய 
்வதது இடது கபோத்தோ்்ன 
அழுததி உடந்ன விடடுவிடு்தல்.

வைது கிளிக

ஒரு உருப்படியின் மீது சுடடி்ய 
்வதது, வைது கபோத்தோ்்ன 
அழுத்த, ஒரு நமல்மீடபுப் படடி 
ந்தோன்றும், அதில் பை விருப்பத 
ந்தரவுகள் படடியலிடப்படும்.

இரு கிளிக 
கசய்தல்

தி்ையில் உள்ை ஒரு 
உருப்படியின் மீது சுடடி்ய 
்வதது, இடது கபோத்தோ்்ன 
இருமு்்ற நவகமோக அழுததி 
வி டு ்த ல் .

இழுதது விடு்தல்

ஒரு உருப்படியின் மீது 
சுடடி்ய ்வதது, சுடடியின் 
இடது கபோத்தோ்்ன அழுததி 
பிடித்தவோறு, சுடடி்ய 
ந்த்வயோ்ன இடம் வ்ை 
இழுதது, பின் விடடுவிடு்தல்.

அடடவ்ண  5.2
5.5. விணநடோஸின் தி்ைமுகப்பு

விணநடோஸின் க்தோடகக தி்ை ”தி்ைமுகப்பு”  
(Desktop) என்று அ்ைககப்படுகி்றது. 
உஙகள் கணிப்கபோறியில் உள்ை தி்ை முகப்பு 
படம் 5.3ல் கோடடப்படடது நபோை இல்ைோமல் 
நவறுபடடிருககைோம். ஏக்னனில் விணநடோஸ் 
அ்தன் ந்தோற்றம், தி்ை முகப்பு ஆகியவற்்ற 
மோறறி அ்மகக வழி கசயகி்றது.
படம் 5.3 -ல் க்தோடகக கபோத்தோன், பணிப்பட்ட, 
அறிவுப்புப் பகுதி, ந்ததி மறறும் ந�ைம் 
ஆகியவற்்றத தி்ைமுகப்பில் கோணைோம்.

• நீஙகள் எந்த பயன்போடடில் நவ்ை கசயது 

ககோணடிருந்தோலும் Winkey + D அல்ைது 

ஏநைோ பீக (Aero Peak) பயன்படுததி எந்த 

ந�ைததிலும் தி்ை முகப்புககுச் 

கசல்ைைோம்.

• பணிப்பட்டயில் ஏநைோ பீக எஙகு உள்ைது 

என்ப்்த படம் 5.4ல் அறியைோம்.

உஙகளுககு க்தரியுமோ?

பணிககுறிகள்

பணிப்பட்ட

அறிவிப்பு பகுதிக்தோடகக கபோத்தோன்

நககஜடடுகள்

படம் 5.3. ்மகநைோசோப்ட விணநடோஸ் 7 

தி்ைமுகப்பு

அறிவிப்பு பகுதிக்தோடகக கபோத்தோன்

படம் 5.3. ்மகநைோசோப்ட விணநடோஸ் 

தி்ைமுகப்பு

ஏநைோ பீக கபோத்தோன்

படம் 5.4. ஏநைோ பீக கபோத்தோன்.

5.5.1. பணிககுறிகள் (Icon)
 விணநடோஸ்-ன் கூறுகைோ்ன நகோப்பு, 

நகோப்பு்்ற, குறுககுவழிகள் நபோன்்றவற்்றக 

குறிககும் படககுறியீடு "பணிககுறி" எ்னப்படும். 

வ்ைக்ைப் பய்னர இ்டமுக (GUI) 

பயன்போடுகளில் பணிககுறிகள் முககிய பஙகு 

வ கி க கி ்ற து .

5.5.1.1 கசந்தை பணிககுறி (Standard 
Ic ons)
  விணநடோஸ் இயகக அ்மப்பு 

நிறுவப்படும் நபோது உருவோககப்படும் ககோடோநி்ை 

பணிககுறிகள், "கசந்தை பணிககுறிகள்" 

(Standard Icons) எ்ன அ்ைககப்படுகி்றது. 

்மகம்ப்யூடடர (My Computer), டோககுகமன்ட 
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(ஈ) கைப்பேசி, ஸ்மார்ட் கைப்பேசி, டேப்ளட் 

(Tablet) ப�ோன்ற நீக்கக்கூடிய நினைவகங்கள்

(உ) உங்கள் கணிப்பொறி பிற கணிப்பொறிகளுடன் 

இணைக்கப்பட்டு இருந்தால், அதன் வலை 

இயக்கி (படம் 5.6 பார்க்க)

பயன்பாட்டு பணி-
க்குறி

க�ோப்புைற 
பணிக்குறி

படம் 5.5.பணிக்குறியின்  வகைகள்

(Documents) மற்றும் ரிசைக்கிள் பின் (Recycle 
Bin) ப�ோன்றவை அைனத்து விண்டோஸ் 

இயக்க அமைப்புகளிலும் காணப்படும் செந்தரப் 

பணிக்குறிகள் ஆகும். 

5.5.1.2. குறுக்கு வழி பணிக்குறிகள் :

	 எந்தெவாரு பயன்பாடு அல்லது  க�ோப்பு 

அல்லது க�ோப்புைறகளுக்கு குறுக்கு வழி 

பணிக்குறிகளை உருவாக்கலாம்.  இதன் மீது இரு 

கிளிக் செய்யப்படும் ப�ோது இதற்கான பயன்பாடு 

/ க�ோப்பு அல்லது க�ோப்புைற திறக்கப்படும்.  

குறிப்பிட்ட பயன்பாட்டைத் திறப்பதற்கான  

குறுக்குவழியாக பணிக்குறிகள் பயன்படுகிறது. 

(படம் 5.5).

5.5.1.3. வட்டு இயக்கி பணிக்குறிகள்	

	 வட்டு இயக்கி பணிக்குறிகள், ஐந்து 

வகையான வட்டு இயக்கிகளைப் படக்குறியீடாக 

வ ழங்  கு கி் ற து .

(அ) வன்வட்டு (C,D,E) 

(ஆ)CD-ROM / DVD வட்டு

(இ) ெபன்டிைரவ் (Pen Drive)

பல்வேறு வட்டு இயக்கி 

பணிக்குறி

ம�ொத்த நினைவக இடம் 

மற்றும் மீதமுள்ள நினைவக 

இடத்துடன் வன்வட்டு இயக்கி

நீக்கக் கூடிய நினைவகம் (பென் இயக்கி)

படம் 5.6.வட்டு இயக்கி பணிக்குறிகள்

5.6. சன்னல் திரை

	 ஒரு ஆவணம் அல்லது பயன்பாட்டின் ப�ொதுவான செவ்வகப் பகுதி "சன்னல்" திரை எனப்படும். 
குறிப்பிட்ட பயன்பாட்டின் தகவல்களைத் திரையிடுவதற்கு  பயன்படும் பகுதியாகும்.
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5.7 பயன்பாட்டு சன்னல்திரை

	த கவல்களைத் திரையிடுவதற்கான, 
வரையறுக்கப்பட்ட எல்லைகளைக் க�ொண்ட 
கணிப்பொறி திரையின் பகுதி, "பயன்பாட்டு 
சன்னல்திரை" எனப்படும். சன்னல் திரைகளை 
சிறிதாக்குதல் (Minimize), பெரிதாக்குதல் 
(Maximize), அருகருகே வைத்தல் (side 
by side), ஒன்றன் மீது ஒன்றாக வைத்தல் 
(Overlap) ப�ோன்ற செயல்களைச் செய்ய 
முடியும். ஒரு பயன்பாட்டு சன்னல்திரை என்பது 
திறக்கப்பட்டுள்ள ஒரு  பயன்பாடு. அதாவது Word, 
Paint ப�ோன்ற இயங்கும் பயன்பாடுகளைக் 
குறிக்கும். இரண்டுக்கும் மேற்பட்ட சன்னல்கள் 
திறந்திருக்கும் ப�ோது அதனுள் ஒன்று மட்டுமே 
செயலில் இருக்கும். மற்றது செயலற்றதாக 
இருக்கும். படம் 5.7 மற்றும் 5.8 ல் ஓபன் ஆஃபீஸ் 
ரைட்டர் பயன்பாட்டு சன்னல் திரை மற்றும் திரை 
முகப்பில் திறந்துள்ள ஒன்றுக்கும் மேற்பட்ட 
சன்னல்களின் த�ோற்றத்தைக் காணலாம்.

5.8. ஆவண சன்னல் திரை

	 ஒரு ஆவணத்தின் உள்ளடக்கத்தைக் 

காட்டும் சன்னல் திரை "ஆவண சன்னல் 

திரை"  எனப்படும். படம் 5.9 ல் ஆவண சன்னல் 

திரைக்கான எடுத்துக்காட்டாகும்.
குறிப்பு

ஓபன் ஆஃபீஸ் ரைட்டர், இம்ப்ரெஸ் 
அல்லது கால்க் ப�ோன்ற பயன்பாடுகளைத் 
திறக்கும் ப�ோது, கணிப்பொறி திரையில் 
இரண்டு சன்னல் திரைகள் ஒன்றினுள் 
ஒன்றாக த�ோன்றும். அதில், பெரிய 
சன்னல் திரை “பயன்பாட்டு சன்னல் திரை” 
என்று அழைக்கப்படுகிறது. இது, பயனர், 
பயன்பாட்டு மென்பொருளுடன் த�ொடர்பு 
க�ொள்ளப் பயன்படுகிறது. பயன்பாட்டு 
சன்னல் திரையின் உள்ளே அமைந்துள்ள 
சிறிய சன்னல் திரை “ஆவண சன்னல் 
திரை” என்று அழைக்கப்படுகிறது. இது, 
உரை மற்றும் படங்களை (graphics) 
உருவாக்கவும், பதிப்பாய்வு செய்யவும், 
படங்களை வரையவும் மற்றும் வடிவூட்டல் 
செய்யவும் பயன்படுகின்றது.

பயன்பாட்டு பணித்தளம்

ஆவணத்தின் தலைப்புடன் "தலைப்புப் பட்டை"

கருவிப் பட்டை

உருளல் பட்டை

பட்டிப் பட்டை

வி
ண

்
ட

ோஸ்
 க

ட்
டு

ப்பாட்
டு

 ப�ொத
்தான்க




ள்
 

படம் 5.7. பயன்பாட்டு சன்னல்திரை

படம் 5.8. ஒன்றுக்கும் மேற்பட்ட சன்னல்கள் 

திரைமுகப்பில் திறக்கப்பட்டுள்ளது
பயன்பாட்டு சன்னல்

ஆவண பகுதி

ஆவண சன்னல்

ரூலர்

படம்  5.9.ஆவண சன்னல் திரையின் கூறுகள்
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5.9. சன்னல் திரையின் கூறுகள்

	 படம் 5.10 சன்னல் திரையின் 

கூறுகளைப்ப புரிந்து க�ொள்ள பயன்படுகிறது.

	 சிறிதாக்கு, பெரியதாக்கு மற்றும் மூடு 

ப�ொத்தான்களும் உள்ளன.

5.9.1 தலைப்புப்பட்டை

	 திறந்துள்ள ஆவணத்தின் பெயரும், 

பயன்பாட்டின் பெயரும் தலைப்புப் பட்டையில் 

த�  ோ ன் று ம் .

5.9.2 பட்டிப்பட்டை

	தல ைப்பு பட்டையின் கீழ் புறம் 

பட்டிப்பட்டை காணப்படும். Alt ப�ொத்தானை 

அழுத்தியவாறே பட்டித் தலைப்பில் அடிக�ோடிட்டு 

த�ோன்றும் எழுத்தினையும் அழுத்தி, 

பட்டிப்பட்டையில் உள்ள பட்டிகளைப் பயன்படுத்த 

முடியும். மேலும் Alt ப�ொத்தான் அல்லது F10 
ப�ொத்தானை அழுத்தினால் பட்டிபட்டையில் 

உள்ள முதல் பட்டியை முன்னிறுத்தும். 

	 விண்டோஸ் 7  இல் பட்டி பட்டை 

இல்லாவிட்டால் organize ப�ொத்தானில் க்ளிக் 

செய்து த�ோன்றும் கீழ்விரிப் பட்டியிலிருந்து 

layout Option கிளிக் செய்து பட்டிப் 

பட்டையைத் த�ோன்றச்செய்யலாம். படம் 5.11ன் 
மூலம் பட்டி பட்டை த�ோன்றாவிட்டால் அதை 

எவ்வாறு த�ோன்றச் செய்வது என்பதைத் தெரிந்து 

க �ொள்ளலா      ம் .
மூலைகள்

மூலைகள் மூலைகள்

உருளல் பட்டை

பணித்தளம்

Menu Bar

மூலைகள்
தலைப்புப் பட்டை

எ
ல

்
லை

க
ள்

எல்லைகள்

எல்லைகள்

படம்  5.10. விண்டோஸின் கூறுகள் 

படம்  5.11. பட்டிப் பட்டையை த�ோன்ற செய்வது

5.9.3. பணித்தளம் 
	 ஒரு ஆவணத்தில் உரையைத் தட்டச்சு 
செய்யும் ஆவண சன்னல் திரையின் பகுதி 
பணித்தளம் ஆகும். படம்  5.10 ஆவண 
சன்னலின் பணித்தளத்தைக் காட்டுகிறது.
5.9.4 உருளல் பட்டை
	 உருளல் பட்டைகள் பணித்தளத்தைச் 
செங்குத்தாகவும், கிடைமட்டமாகவும் உருள 
செய்யப் பயன்படுகிறது. படம் 5.10 உருளல் 
பட்டையின் த�ோற்றத்தைக் காட்டுகிறது.
5.9.5 மூலைகள் மற்றும் எல்லைகள்
	 விண்டோஸில் அளவை மாற்றி அமைக்க 
மூலை மற்றும் எல்லை உதவி செய்கிறது.
சன்னல் திரையின் மூலைகள் மற்றும் 
எல்லைகளின் மீது சுட்டியின் அம்புக்குறியை 
வைக்கும்போது, அது இருதலை க�ொண்ட 
அம்புக்குறியாக மாறும். இருதலை 
அம்புக்குறியின் திசைக்கு ஏற்ப இழுக்கும் ப�ோது, 
சன்னல் திரையின் அளவு மாறும் (படம் 5.10யை 
காண்க). சன்னலின் மூலைவிட்டத்தில் இருதலை 
அம்புக்குறியை வைத்து இழுக்கும்போது, அதன் 
அளவு மாற்றப்படும். 

5.10 கணினியை ஆராய்தல்

5.10.1 த�ொடக்கப்பட்டி
	 திரைமுகப்பின் கீழ் இடது கை 
மூலையில் த�ொடக்க ப�ொத்தான் உள்ளது. 
த�ொடக்க ப�ொத்தானைக் கிளிக் செய்யும் 
ப�ோது த�ொடக்கப்பட்டி த�ோன்றும். மேலும் 
அதை பயன்படுத்தி எந்த ஒரு பயன்பாட்டையும் 
த�ொ   ட ங ்கலா   ம் .
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பணிப்பட்டை

	 திரைமுகப்பின் கீழே உள்ள 
கிடைமட்ட பட்டை “பணிப்பட்டை” (Taskbar) 
என்று அழைக்கப்படுகிறது. இந்த பட்டை, 
(இடமிருந்து வலமாக) த�ொடக்கப் ப�ொத்தான், 
பல்வேறு பயன்பாடுகளின் குறுக்குவழிகள், 
சிறிதாக்கப்பட்ட பயன்பாடுகளை 
க�ொண்டிருக்கும். மேலும், அதன் வலதுக�ோடியில், 

ஒலி கட்டுப்பாட்டகம், வலையமைப்பு, தேதி 
மற்றும் நேரம் ப�ோன்ற வசதிகளை உள்ளடக்கிய 
”கணினி அமைப்பு தட்டு” (System tray)  
உள்ளது. அடிக்கடி பயன்படுத்தப்படும் 
பயன்பாடுகளைக் க�ொண்டிருக்கும். ”விரைவு 
த�ொடக்க கருவிப்பட்டை” (Quick launch 
toolbar), த�ொடக்க ப�ொத்தானுக்கு அடுத்ததாக 
உ ள்ள  து .

இந்த தேர்வுடன் 
மேலும் துணை-
ப்பட்டி உள்ளதைக் 
காட்டும் குறியீடு.

கணிப்பொறி அமைப்பை மா-
ற்றுவது

(கட்டுப்பாட்டு பலகம்)

இதர சாதனங்கள் 
மற்றும் அச்சுப் ப�ொ-
றிகளைச் சேர்த்தல் / 

மாற்றுதல்

உதவி பெறுதல்

வெளியேறுதல் / மீண்டும் த�ொ-
டங்குதல், பணி  நிறுத்தம்

நிறுவப்பட்ட 
பயன்பாடுகள்

தேடல் பெட்டி

த�ொடக்க 
ப�ொத்தான்

படம் 5.12.த�ொடக்க பட்டி 
த�ொடக்கப் ப�ொத்தான்

சிறிதாக்கப்பட்ட 
பயன்பாடுகளும், க�ோ-

ப்புைறகளும்

மறைக்கப்பட்ட பணி-
க்குறிகளைக் காட்டும்

தானமைவு 
ம�ொழி

வலையமைப்பு 
பணிக்குறி

ஒலி சரிசெ-
ய்தல்

நேரம் மற்றும்  நாள்

ஏர�ோபீக் 
ப�ொத்தான்

படம்  5.13 பட்டிப்பட்டை
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5.10.2 கணிப்பொறி பணிக்குறி

	 இந்த பணிக்குறியைக் கிளிக் செய்தால், 
கணிப்பொறியுடன் இணைக்கப்பட்டுள்ள 
வட்டு இயக்கிகளைப் பயனர் காண முடியும். 
விண்டோஸ் XP மற்றும் விஸ்டா பதிப்புகளில், 
இந்த பணிக்குறி “மை கம்ப்யூட்டர்” (My 
Computer) என்றும், விண்டோஸ் 8 மற்றும் 
10ல் ”திஸ் பீஸி” (This PC) என்றும் 
அழைக்கப்படுகிறது. இந்த பணிக்குறியின் 
செயல்பாடு விண்டோஸ்-ன் அனைத்து 
பதிப்புகளுக்கும் ப�ொதுவானதாகும். (படம்  
5.14 யை காண்க)

5.10.3 பயன்பாட்டைத் த�ொடங்குதல் மற்றம் 
மூ டு த ல் 
	 கணிப்பொறியில் நிறுவப்பட்டுள்ள 
பெரும்பாலான பயன்பாடுகள், த�ொடக்கப்பட்டியில் 
கிடைக்கும். கணிப்பொறியின் அமைப்பைப் 
ப�ொறுத்து த�ொடக்கப் பட்டியில் உள்ள பயன்பாடுகள் 
வே  று ப டு கி ன ்ற ன . 

1.	 ஒரு பயன்பாட்டைத் த�ொடங்குவதற்கு: Start 
ப�ொத்தானைக் கிளிக் செய்து, All Programs 
ல் சுட்டியை வைக்கவும்.  நிரல் பட்டி படம் 5.15 
ல் உள்ளவாறு த�ோன்றும்.

2.	 நீங்கள் த�ொடங்க விரும்பும் பயன்பாட்டைக் 
க�ொண்ட குழுவில் சுட்டியை வைத்து, பின்னர் 

பயன்பாட்டின் பெயரைக் கிளிக் செய்யவும்.

படம்  5.14 விண்டோஸ் இயக்க அமைப்பு பதிப்பில் உள்ள மைகம்ப்யூட்டர் பணிக்குறி

படம் 5.15 த�ொடக்கப் ப�ொத்தானைப் 

பயன்படுத்த பயன்பாட்டைத் த�ொடங்குதல்.

3.	த�ொ டக்க  பட்டியிலுள்ள Run என்பதைக் கிளிக் 

செய்து, த�ோன்றும் பெட்டியில், திறக்கப்பட 

வேண்டிய பயன்பாட்டின் பெயரைத் தட்டச்சு 

செய்தும், ஒரு பயன்பாட்டைத் த�ொடங்கலாம். 

(படம் . 5.16   யை காண்க)

படம்  5.16. Run கட்டளையைப் பயன்படுத்தி 

பயன்பாட்டைத் த�ொடங்குதல்

4.	 ஒரு பயன்பாட்டை விட்டு வெளியேற 
பயன்பாட்டு சன்னல் திரையின் மேல் வலது 

மூலையில் உள்ள மூடு ப�ொத்தானைக் கிளிக் 

செய்க. (படம் 5.17)
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மூடு ப�ொத்தான்

வெளியேறு

படம் 5.17. மூடு (Close) மற்றும் வெளியேறு (Exit)
ப�ொத்தானைப் பயன்படுத்தி வெளியேறுதல்

5.	  File → Exit அல்லது File → Close 

கட்டளைகளையைப் பயன்படுத்தியும், ஒரு 

பயன்பாட்டிலிருந்து வெளியேறலாம்.

பயிற்சி பட்டறை

	த�ொ டக்கப்  பட்டி மற்றும் RUN தேர்வு 
பயன்படுத்தி Word Pad பயன்பாட்டைத் 

த�ொ   ட ங் கு க .

	 File பட்டியைப் பயன்படுத்தி Word Pad ஐ 

மூடுக.

5.11 க�ோப்புகளையும், 
க�ோப்புைறகளையும் நிர்வகித்தல்

	 விண்டோஸ் 7 ல், ஆவணங்கள் மற்றும் 
நிரல்களைக் க�ோப்புகள் மற்றும் க�ோப்புைறகளாக  
நிர்வகிக்கலாம். க�ோப்பு மற்றும் க�ோப்புைறகளை 
நகர்த்துதல், நகலெடுத்தல், மாற்றுப்பெயரிடுதல், 
நீக்குதல் மற்றும் தேடல் ப�ோன்ற செயல்களைச் 
செய்ய முடியும்.

5.11.1. க�ோப்பு மற்றும் க�ோப்புைறகளை 

உ ரு வ ாக்  கு த ல்

5.11.1.1 க�ோப்புைறகளை உருவாக்குதல்

	 உங்கள் க�ோப்புகளைப் பல இடங்களில் 

சேமிக்கலாம் - வன்வட்டு அல்லது பிற 

இயக்கிகளில். உங்கள் க�ோப்புகளை சிறப்பாக 

அமைக்க க�ோப்புைறகளில்  சேமிக்கலாம். 

புதிய க�ோப்புைறயை உருவாக்க இரண்டு 
வழிமுறைகள் உள்ளன.

முறை 1
படி 1.	 கம்ப்யூட்டர் குறும்படத்தை திறக்கவும்

படி2.	 புதிய க�ோப்புைறயை உருவாக்க விரும்பும் 
இயக்கியை திறக்கவும். (உதாரணம் D:/)

படி3.	 File  New  Folder கிளிக் செய்க.

படி4.	 புதிய க�ோப்புைற, தானமைவாக “New 
Folder” என (படம் 5.19) காட்டியவாறு 
உ ரு வ ா கு ம் .

படி 5.	 க�ோப்புைறயின் பெயரைத் தட்டச்சு 
செய்து, Enter ப�ொத்தானை அழுத்தவும். 
(புதியதாக உருவாக்கப்பட்ட க�ோப்புைற  
"test folder" என ெபயரிடப்பட்டுள்ளதைப்  
படம் 5.20 காண்க)

படம் 5.18. File பட்டியைப் பயன்படுத்தி 

க�ோப்புைறகளை உருவாக்குதல்.

படம் 5.19 தானமைவு பெயரில் புதிதாக 

உருவாக்கப்பட்ட க�ோப்புைற
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படம் 5.20. புதிதாக உருவாக்கப்பட்ட 
க�ோப்புைறக்கு  மறுபெயரிடுதல்.

முறை 2
திரைமுகப்பில் க�ோப்புைறயை உருவாக்க

படி 1- �திரைமுகப்பில் சுட்டியின் வலது 
ப�ொத்தானைக் கிளிக் செய்து, New 
 Folder  கட்டளையைக் கிளிக் செய்க. 
(படம் 5.21)

படி 2- �பெயரிடப்படாத ஒரு new folder என்ற 
க�ோப்புைற த�ோன்றுகிறது (படம் 5.22)

படி 3- �க�ோப்புைறக்கு ஒரு பெயர் தட்டச்சு 
செய்து. Enter ப�ொத்தானை 
அ ழு த ்த வு ம் .

படி 4 – �க�ோப்புைறயின் பெயர் மாற்றம் பெறும். 
(படம் 5.20)

2. மை டாக்குமென்ட் (My Document) ல், நாம் 
பயின்ற ஏதேனும் ஒரு முறையைப் பயன்படுத்தி 
ஒரு க�ோப்புைறயை உனது பெயரில் 
உருவாக்கவும். 

பயிற்சி பட்டறை

5.11.1.2 க�ோப்பு உருவாக்குதல் (வேர்டு பேட்)
வேர்டு பேட் (Word Pad) விண்டோஸ் இயக்க 
அமைப்பின் உள்ளிணைந்த ச�ொற்செயலி 
பயன்பாடாகும். உரை ஆவணங்களை 
உருவாக்கவும், கையாளவும் இது 
ப ய ன்ப  டு கி ற து . 
	 இதில் க�ோப்பினை உருவாக்க 
விரும்பினால் கீழ்க்காணும் படிநிலைகளைப் 
பி ன்ப  ற ்ற வு ம் .

படம் 5.21. திரை முகப்பில் க�ோப்புைறயை 

உருவாக்குதல்.

1.	  Start  All Programs  Accessories  
Wordpad அல்லது Run  type Wordpad 
என தட்டச்சு செய்த பிறகு ok ப�ொத்தானைக் 

கிளிக் செய்ய வேண்டும்.

	 Word Pad சன்னல் திரை படம் 5.23 ல் 

காட்டியுள்ளவாறு திறக்கப்படும்.

2.	 பணித்தளத்தில் தட்டச்சு செய்யப்பட 

வேண்டிய உரையைத் தட்டச்சு செய்து, File 

 Save அல்லது Ctrl + S  பயன்படுத்தவும். 
3.	 Save As உரையாடல் பெட்டி திரையில் 

த�  ோ ன் று ம்

4.	 அந்த உரையாடல் பெட்டியில் ஆவணத்தை 

எங்கு சேமிக்க வேண்டும�ோ அதை  
look –in கீழிறக்குப்  பெட்டியில் தேர்வு செய்ய 

வேண்டும்.

5.	 File name என்ற உரைப்பெட்டியில் க�ோப்பின் 

பெயரைத் தட்டச்சு செய்ய வேண்டும்.

6.	 Save ப�ொத்தானைக் கிளிக் செய்ய வேண்டும் 

படம் 5.22. திரைமுகப்பில் புதிய க�ோப்புைற
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படம்  5.23.Word pad- ச�ொற்செயலி பயன்பாடு

3.	 Wordpad- யை பயன்படுத்தி ஒரு 
ஆவணத்தை உருவாக்கி பின் அதை 
மை டாக்குமென்டில் உள்ள உங்கள் 
பெயரில் உருவாக்கப்பட்ட க�ோப்புைறயில் 
சே  மி க ்க வு ம் .

பயிற்சி பட்டறை

5.11.2. க�ோப்பு மற்றும் க�ோப்புைறகளைத் 
தேடுதல்

கணினியில் அல்லது குறிப்பிட்ட இயக்கிகளில் 

உள்ள க�ோப்பு அல்லது க�ோப்புறையை விரைவாக 

த�ொடக்கப் ப�ொத்தானிலுள்ள Search பெட்டி 

பயன்படுத்தப்படுகிறது.

படம் 5.24. த�ொடக்க பட்டியைப் பயன்படுத்தி 

க�ோப்பு அல்லது க�ோப்புறையைக் கண்டுபிடித்தல்.

க�ோப்பு அல்லது க�ோப்புறையைக் கண்டுபிடிக்க

1.	 Start ப�ொத்தானை கிளிக் செய்யவும், 
த�ொடக்க பட்டியின் கடைசியில் Search 
பெட்டி காணப்படும்.

2.	தே டப்பட வேண்டிய க�ோப்பு அல்லது 
க�ோப்புைறயின் பெயரை Search  
பெட்டி - ல் தட்டச்சு செய்க. தேடவேண்டிய 
க�ோப்பு அல்லது க�ோப்புைறயின் பெயரில் 
ஒரு பகுதியை நீங்கள்கொடுத்தாலே 
ப�ோதும்.

3.	 குறிப்பிடப்பட்ட பெயரிலுள்ள க�ோப்பு அல்லது 
க�ோப்புைறகள் திரையில் த�ோன்றும். அந்த 
க�ோப்பு அல்லது க�ோப்புைறயை கிளிக் 
செய்தால், அது நேரடியாக திறக்கும்.

4.	 Search பெட்டிக்கு மேலே “See more 
results” என்ற மற்றொரு தேர்வும் உள்ளது.

5.	 இந்த தேர்வைக் கிளிக் செய்யும் ப�ோது, 
Search Results உரையாடல் பெட்டி 
த�ோன்றும். இதன் மூலம், க�ோப்பு அல்லது 
க�ோப்புைறகளை தேடித், திறக்கலாம். 

க�ோப்பு அல்லது க�ோப்புைறயை கம்ப்யூட்டர் 
பணிக்குறி  மூலம் தேடுதல்.

படி 1	 கம்ப்யூட்டர் பணிக்குறியை திரை முகப்பில் 
தேர்வு செய்க அல்லது Start பட்டி மூலம்  
தேர்வு செய்க.

படி 2	 கம்ப்யூட்டர் வட்டு இயக்கி(Disk Drive) 
என்ற திரை, மேல் வலது மூலையில் 
த�ோன்றும்.அதில் Search box தேர்வு 
உள்ளது. (படம் 5.25) 

படி 3	 அதில் க�ோப்பு அல்லது க�ோப்புைறயின்  
பெயரை தட்டச்சு செய்க. க�ோப்பு அல்லது 
க�ோப்புைற பெயரின் ஒரு பகுதியை  
க�ொடுத்தால் குறிப்பிட்ட பெயரில் 
த�ொடங்கும் அனைத்து க�ோப்பு அல்லது 
க�ோப்புைறகளைக் காட்டும்.

படி 4	 க�ோப்பு அல்லது க�ோப்புைறயை திறக்க 
அதனை கிளிக் ெசய்யவும்.
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படம் 5.25. 'கம்ப்யூட்டர்' பணிக்குறியைப் பயன்படுத்தி, க�ோப்புஅல்லது க�ோப்புைறயைத் தேடுதல்.

4.	 மேலே கூறியுள்ள முறைகளைப் 
பின்பற்றி நீங்கள்  பயிற்சி பட்டறை 3 ல் 
உருவாக்கிய க�ோப்பினைத் தேடவும்.

பயிற்சி பட்டறை

5.11.3. முன்னரே உருவாக்கிய க�ோப்பு அல்லது 

க�ோப்புைறயைத் திறத்தல்

க�ோப்பு அல்லது க�ோப்புைறயைத் திறக்க மிக 

ப�ொதுவான வழி, அதை இரட்டைக் கிளிக் 

செய்தல் ஆகும்.

5.11.4 க�ோப்பு அல்லது க�ோப்புைறக்கு 

ம று பெ  ய ரி டு த ல்

	 க�ோப்பு மற்றும் க�ோப்புைறக்கு 

மறுபெயரிடுவதற்கு பல வழிகள் உள்ளன.

File பட்டி அல்லது இடது சுட்டிப் ப�ொத்தான் 

அல்லது வலது சுட்டிப் ப�ொத்தானைப் 

பயன்படுத்தி மறுபெயரிடலாம்.

முறை 1

File பட்டியைப் பயன்படுத்தி மறுபெயரிடுதல்

1.	 மறுபெயரிட வேண்டிய க�ோப்பு அல்லது 

க�ோப்புைறயைக் கிளிக் செய்க.

2.	 கிளிக் File -> Rename

3.	 புதிய பெயரைத் தட்டச்சு செய்க.

4.	 படம் 5.26 ல் காட்டியபடி மறு பெயரிடும் 

செயலினை முடிக்க  Enter  ப�ொத்தானை 

அழுத்தவும் அல்லது OK ப�ொத்தானைக் 

கிளிக் செய்யவும்.

படம் 5.26. File பட்டியைப் பயன்படுத்தி க�ோப்பு 

அல்லது க�ோப்புைறக்கு மறுபெயரிடுதல்

படம் 5.27. மறுபெயரிடப்பட்ட க�ோப்புைற படம்

5.27 SCERT  என்ற  க�ோப்புைற SCERT-
DPI என மாற்று பெயரிடப்பட்டுள்ளதைக் 

காணலாம்.
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முறை   2 

சுட்டியின் வலது ப�ொத்தானைப் பயன்படுத்துதல்.

படி 1- மறுபெயரிட விரும்பும் க�ோப்பு அல்லது 

க�ோப்புைறயைத் தேர்வு செய்க.

படி 2  க�ோப்பு அல்லது க�ோப்புைறயின் மீது 

சுட்டியின் வலது ப�ொத்தானைக் கிளிக் 

செய்க. (படம் 5.28)

படி 3 மேல் மீட்புப் பட்டித் த�ோன்றும். அதில் 

rename என்ற கட்டளையைத் தேர்வு  செய்க. 

படி 4  புதிய பெயரைத் தட்டச்சு செய்க.

படி 5  மறு பெயரிடும் செயலினை முடிக்க Enter   
அல்லது OK ப�ொத்தானை அழுத்தவும்.

படம்  5.29ல். New Folder  என்ற க�ோப்புைற 

C++  என பெயர் மாற்றம் செய்யப்பட்டுள்ளது.

படம் 5.28. க�ோப்பு அல்லது க�ோப்புைறயைச் 

சுட்டியின் வலது ப�ொத்தானைப் பயன்படுத்தி  

மறுபெயரிடுதல்

படம்  5.29. C++என பெயர் மாற்றம் செய்யப்பட்ட 
க�ோப்புைற

முறை 3 
சுட்டியின் இடது ப�ொத்தானைப் பயன்படுத்தி 
மறுபெயரிடுதல்.
படி 1- 	 மறுபெயரிட விரும்பும் க�ோப்பு அல்லது 

க�ோப்புைறயைத் தேர்வு செய்க.
படி 2 – F2 ப�ொத்தானை அழுத்த வேண்டும் 
அல்லது க�ோப்பு அல்லது க�ோப்புைறயின் மீது  
கிளிக் செய்ய வேண்டும். க�ோப்பின் பெயரை சுற்றி 
ஒரு செவ்வக வடிவம் த�ோன்றும்.
படி 3 – புதிய பெயரைத் தட்டச்சு செய்க.
படி 4 – மறு பெயரிடும் செயலினை முடிக்க Enter   

அல்லது  OK ப�ொத்தானை அழுத்தவும்.

5. நீங்கள் உருவாக்கிய க�ோப்பினை File 
பட்டி, இடது சுட்டி, வலது சுட்டி  பயன்படுத்தி 

மறுபெயரிடுக.

பயிற்சி பட்டறை

5.11.5. க�ோப்பு மற்றும் க�ோப்புைறயை 
நகலெடுத்தல் அல்லது நகர்த்துதல்
	க� ோப்பு  மற்றும் க�ோப்புைறயை பிற 
பகுதிகளுக்கு நகர்த்துவதற்கு பல வழி முறைகள் 
உ ள்ளன   .
க�ோப்பு மற்றும் க�ோப்புைறயை நகர்த்துதல்:
முறை 1-வெட்டுதல் மற்றும்  ஒட்டுதல் 
•	 ஒரு க�ோப்பு அல்லது ஒரு க�ோப்புைறயை 

நகர்த்துவதற்கு முதலில் தேர்ந்தெடுக்க 
வேண்டும். பிறகு கீழ் வரும் வழி முறைகளில் 
ஏதேனும் ஒன்றை செய்க.

•	 Edit → Cut அல்லது Ctrl + Xஅல்லது 
வலது சுட்டி ப�ொத்தானை அழுத்தினால் 
மேல் மீட்புப் பட்டித் த�ோன்றும். அதில் Cut 
என்பதை தேர்வு செய்க.  

•	 க�ோப்பு அல்லது க�ோப்புைறயை புதிய 
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இடத்திற்கு நகர்த்துவதற்கு Edit→ Paste  
அல்லது  Ctrl + V     என்ற சாவி சேர்மானத்தை 
அல்லது வலது சுட்டி ப�ொத்தானை 
அழுத்தினால் மேல் மீட்புப் பட்டித் த�ோன்றும். 
அதில் Paste என்ற கட்டளையைத் தேர்வு 
செய்தால் , க�ோப்பு புதிய இடத்திற்கு 
ந க ர ்த ்த ப்ப  டு ம் .

முறை 2 – இழுத்துவிடுதல்	

•	 விண்டோஸின் இயக்க வட்டு சன்னல் 
திரையில், இடது மற்றும் வலது சாளரப் 
பிரிவுகள் உள்ளன. இடது சாளரப் பிரிவில் 
க�ோப்பு மற்றும் க�ோப்புைறகள் மரக் 
கிளைகள் ப�ோல் காட்சியளிக்கும். வலது 
சாளரப் பிரிவில், இடது சாளரத்தில் உள்ள ஒரு 
குறிப்பிட்ட க�ோப்பு அல்லது க�ோப்புைறகள் 
பல்வேறு விருப்பங்களுடன் காட்டப்படும். 

•	 இயக்க வட்டு சன்னல் திரையில்  நகர்த்தப்பட 
வேண்டிய க�ோப்பு அல்லது க�ோப்புைறகளை 
தேர்வு செய்க. 

•	 வலது பக்க சாளரத்தில் உள்ள க�ோப்பு 
அல்லது க�ோப்புைறயை இழுத்து, இடது பக்க 
சாளரப் பிரிவு க�ோப்புப்பட்டியில் சேர்க்கவும். 
பிறகு சுட்டியின் ப�ொத்தானை விடுவிக்கவும். 

•	 உங்கள் க�ோப்பு அல்லது க�ோப்புைறகள் 
புதிய பகுதியில் த�ோன்றும்.

படம்  5.30. இழுத்து விடுதல் முறையில் க�ோப்பு 
அல்லது க�ோப்புைறயை நகர்த்துதல்.

5.11.6 க�ோப்பு மற்றும் க�ோப்புைறகளை 
ந க லெ  டு த ்த ல்
	 க�ோப்பு மற்றும் க�ோப்புைறகளை 
நகலெடுக்க பல வழிகள் உள்ளன.
முறை 1
நகலெடுத்தல் மற்றும் ஒட்டுதல்
1.	ந கலெடுக்க வேண்டிய க�ோப்பு அல்லது 

க�ோப்புைறயை தேர்வு செய்க.
2.	 Edit → Copy  அல்லது Ctrl + C அல்லது 

சுட்டியின் வலது ப�ொத்தானை அழுத்தினால் 
மேல் மீட்புப் பட்டித் த�ோன்றும். அதில் Copy 
என்ற கட்டளையை தேர்வு செய்து புதிய 
இடத்தில் க�ோப்புைறயை ஒட்ட வேண்டும்.

3.	 ஒட்டுவதற்கு Edit → Paste அல்லது  Ctrl + 
V யைக் கிளிக் செய்ய வேண்டும்.

4.	 அல்லது, சுட்டியின் வலது ப�ொத்தானை 

அழுத்தினால் மேல்மீட்புப் பட்டித் த�ோன்றும். 

அதில் Paste என்ற கட்டளையை தேர்வு 

செய்க.

முறை 2 இழுத்துவிடுதல்
1.	 வலது சாளரப் பகுதியில் நகலெடுக்க 

வேண்டிய க�ோப்பு அல்லது க�ோப்புைறயைத் 
தேர்வு செய்ய வேண்டும்.

2.	தேர் வு செய்த க�ோப்பு அல்லது க�ோப்புைறயை, 
இடது சாளரப் பகுதியில் க�ோப்புைறப்பட்டியில் 
இழுத்து விட வேண்டும்.

3.	 புதிய பகுதியில் க�ோப்பு மற்றும் க�ோப்புறை 
த�  ோ ன் று ம்

3.	 புதிய இடத்தில் க�ோப்பு அல்லது க�ோப்புரை 
காணப்படும்.

குறிப்பு

ஒன்றுக்கும் மேற்பட்ட க�ோப்பு 

அல்லது க�ோப்புைறயைத் தேர்வு செய்ய  

Ctrl + Click யைப் பயன்படுத்த வேண்டும்.

5.11.6. நீக்கக் கூடிய வட்டிற்கு க�ோப்பு மற்றும் 
க�ோப்புைறயை நகலெடுத்தல்

	 நீக்கக் கூடிய வட்டிலிருந்து அல்லது 
வட்டுக்கு ஒரு க�ோப்பு அல்லது க�ோப்புைறயை 
நகலெடுக்க அல்லது அனுப்ப பல வழிகள் உள்ளன. 
1.	 நகலெடுத்தல் மற்றும் ஒட்டுதல்

2.	 Send To
முறை 1
நகலெடுத்தல் மற்றும் ஒட்டுதல்
	 USB flash இயக்கியை USB ல்  நேரடியாக 
இ ணை  க ்க வு ம் .
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•	 இணைக்கப்பட்ட USB flash இயக்கி 
தானாக திறக்கவில்லை எனில், கீழ்காணும் 
வழிமுறையைப் பின்பற்றுக.

•	 Start Computer கிளிக் செய்க. (படம் 5.31)
•	 நீக்கக்கூடிய இயக்கியுடன் த�ொடர்புடைய 

USB flash இயக்கியை இருகிளிக் செய்க. 
இப்போது, USB இயக்கி திறக்கப்படும். (படம் 
5.32)

•	 நகலெடுக்க வேண்டிய க�ோப்பின் மீது 
சுட்டியின் வலது ப�ொத்தானைக் கிளிக் செய்து 
த�ோன்றும் மேல் மீட்புப் பெட்டியிலிருந்து, 
Copy தேர்வைக் கிளிக் செய்க.

•	 இப்போது USB இயக்கிக்கு திரும்பி, காலி 
இடத்தில், சுட்டியின் வலது ப�ொத்தானைக் 
கிளிக் செய்து, கிடைக்கும் மேல்மீட்புப் 
பட்டியிலிருந்து, Paste தேர்வைக் கிளிக் 
செய்யவும். (படம் 5.34)

முறை – II Sent To
•	 USB flash இயக்கியை நேரடியாக USBல் 

இணைக்கவும்.

•	 க�ோப்புகள் அடங்கியுள்ள க�ோப்புைறயைத் 
திறந்து க�ொள்ளவும்.

•	 மாற்றப்பட வேண்டிய க�ோப்பின் மீது சுட்டியின் 
வலது ப�ொத்தானைக் கிளிக் செய்க.

•	 த�ோன்றும் மேல்மீட்பு பட்டியில், Send To 
என்ற தேர்வைக் கிளிக் செய்து, அதில் 
த�ொடர்புடைய USB flash இயக்கியைத் 
தேர்வு செய்க. (படம் 5.35)

படம் 5.31 Start பட்டி மூலம் கம்ப்யூட்டரைத்  

தேர்வு செய்தல்.

படம் 5.32 நீக்க கூடிய இயக்கியை இரட்டைக் 
கிளிக் செய்தல்

படம் 5.33 சுட்டியின் வலது ப�ொத்தானை Click 
செய்து க�ோப்பை நகலெடுத்தல்

6.	 நீங்கள் உருவாக்கிய க�ோப்பை மை 

கணினியில் இருந்து D வட்டு இயக்கிக்கு 

நகர்த்தவும்.

	 D:/ வட்டி இயக்கியில் உருவாக்கப்பட்ட 

க�ோப்ைப நீக்கக்கூடிய இயக்கிக்கு 

ம ாற்  று க .

பயிற்சி பட்டறை
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படம் 5.34 வலது கிளிக் மூலம் ஒட்டுதல்

5.11.7. க�ோப்பு மற்றும் க�ோப்புைறகளை 

நீ க் கு த ல்

•	 வட்டு இயக்கிகளிலிருந்து க�ோப்பு அல்லது 

க�ோப்புைறயை நீக்கும் ப�ோது அவை Recycle 
bin-க்கு நகரும்.

க�ோப்பு மற்றும் க�ோப்புைறகள் நீக்குதல்

	 நீக்கப்பட வேண்டிய க�ோப்பு அல்லது 

க�ோப்புைறயைத் தேர்வு செய்து க�ொள்க.

	 சுட்டியால் க�ோப்பு அல்லது க�ோப்புைறயை 

வலது ப�ொத்தானால் கிளிக் செய்யவும், மேல் 

மீட்பு பட்டி த�ோன்றும், அதிலிருந்து Delete என்ற  

விருப்பத்தைத் தேர்ந்தெடுக்கவும். அல்லது விசை 

பலகையில் Delete ப�ொத்தானை அழுத்தவும். 

க�ோப்பானது நீக்கம் செய்யப்பட்டு Recycle bin-
க்கு நகர்த்தப்படும்.

	 File → delete கிளிக் செய்யவும்

7.	 நீங்கள் உருவாக்கிய க�ோப்ைப My 
Document-ல் நகலெடுத்துக் க�ொண்டு,  

அதனை மூல பதிப்பை நீக்கவும்.

பயிற்சி பட்டறை

நீக்க கூடிய இயக்கி 

Removable disk

படம் 5.35. Send to மூலம் க�ோப்பை நகலெடுத்தல்

குறிப்பு
	 ஒரு க�ோப்பு அல்லது க�ோப்புைறயை 

நிரந்தரமாக கணிப்பொறியில் இருந்து 

Recycle bin-ல் தங்காமல் நீக்க SHIFT 

விசையுடன் Delete விசையும் சேர்த்து 

அழுத்த வேண்டும்.

மறு சுழற்சி த�ொட்டி (Recycle bin) 

	 மறுசுழற்சி த�ொட்டி என்பது, பயனரால் 
நீக்கப்பட்ட க�ோப்பு அல்லது க�ோப்புைறகள், 
தற்காலிகமாக சேமிக்கப்படும் சிறப்பு 
க�ோப்புைறயாகும். அழிக்கப்பட்ட க�ோப்புகளை 
மீட்டெடுக்க இது மீண்டும் ஒரு வாய்ப்பை 
வழங்குகிறது.  மறுசுழற்சித் த�ொட்டியிலுள்ள 
க�ோப்புகள் மட்டும் க�ோப்புைறகளை 
மீட்டெடுக்காமல் இயக்க முடியாது.

	 மறுசுழற்சி த�ொட்டியிலுள்ள ஒரு க�ோப்பு 
அல்லது க�ோப்புைறயை மீட்டெடுத்தல்:

•	 திரைமுகப்பிலிருந்து மறுசுழற்சி த�ொட்டியைத் 
திறக்கவும்.

•	 அதில், அழிக்கப்பட்ட க�ோப்புகள் அல்லது 
க�ோப்புைறகள் த�ோன்றும். மீட்டெடுக்க 
வேண்டிய க�ோப்பு அல்லது க�ோப்புைறயின் 
மீது வலது கிளிக் செய்யவும். அப்போது 
த�ோன்றும் மேல்மீட்புப் பட்டியிலிருந்து, Restore 
தேர்வைக் கிளிக் செய்யவும்.

•	 மறுசுழற்சி த�ொட்டியிலுள்ள அனைத்து க�ோப்பு 
அல்லது க�ோப்புைறகளையும் மீட்டெடுக்க, 
Restore all என்ற பணிக்குறியைக் கிளிக் 
செய்யவும்.

•	 மறுசுழற்சி த�ொட்டியிலுள்ள அனைத்து க�ோப்பு 
அல்லது க�ோப்புைறகளையும் நிரந்தரமாக 
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அழித்துவிட, “Empty Recycle bin” என்ற பணிக்குறியைக் கிளிக் செய்யவும். 

5.12 முகப்புத் திரையில் குறுக்கு வழி பணிக்குறி்களை உருவாக்குதல்.

	 உங்கள் வேலையைத் தானியங்கியாக மாற்றுவதற்கு உங்களுக்கு அடிக்கடி பயன்படும் க�ோப்புகள் 
மற்றும் க�ோப்புைறகளின் குறுக்கு வழிகளை உருவாக்கி, அதை முகப்புத் திரையில் வைக்கலாம்.  
திரை முகப்பில் க�ோப்பு அல்லது  க�ோப்புைறயின் குறுக்கு வழியைத் தேர்ந்தேடுக்கவும். வலது கிளிக் செய்யவும்.

•	 ஒரு மேல்மீட்புப் பட்டி த�ோன்றும். அதிலிருந்து Send to  Desktop (Create Shortcut) என்ற தேர்வை 
கிளிக் செய்க.

•	 விண்டோஸ் திரைமுகப்பில், க�ோப்பு அல்லது க�ோப்புைறயின் குறுக்குவழி பணிக்குறி த�ோன்றும். 
(படம் 5.36)

படம் 5.36 குறுக்கு வழி பணிக்குறி  முகப்புத் திரையில் உருவாக்குதல்

5.13. ஒரு கணிப்பொறியிலிருந்து முறையாக வெளியேறுதல்

	 அனைத்து பயன்பாடுகளையும் மூடிவிட்ட பின்னர், கணிப்பொறியின் இயக்கத்தை முறையாக 

நிறுத்தவிட்டு வெளியேற வேண்டும்.

Logoff/shutdown செய்ய:

•	 Start -> log off  அல்லது  Start -> Shut down கிளிக் செய்க. (படம் 5.37) 

•	 ஏதேனும் திறந்த நிரல்கள் இருக்குமாயின் அதை மூடச் ச�ொல்லி விண்டோஸ் கேட்கும், 
அவ்வாறு மூடாமல் விட்டால் கட்டாயப்படுத்தி (Force Shut Down) மூடும், அதனால் சேமிக்காத 
தகவல்களை இழக்க நேரிடலாம்.

XI Std Computer Science Vol-1 TM Chapter 5 090-130.indd   79 4/11/2020   11:44:09 AM



80

Figure 5.37. Log off தேர்வு
•	 Switch User
	 அடுத்த பயனர் கணக்கினுள் திறக்கப்பட்ட 
நிரல்கள் மற்றும் விண்டோஸின் செயல்களை 
மூடாமலே நுழைய விண்டோஸ் வழி வகுக்கும்.

•	 Log off
	 திறந்துள்ள அனைத்து நிரல்களும் முடிந்த 
பின்னரே அடுத்த பயனர் கணக்கிற்கு மாற்றம்  
செய்ய இயலும்.

•	 Lock
	 கணினியை விட்டு த�ொலைவில் இருக்கும் 
ப�ொழுது கணினியைப் பூட்டும் வசதி உள்ளது.

•	 Restart
	 கணிப்பொறியை மறு த�ொடக்கம் செய்வது 
(விண்டோஸ் இயக்க அமைப்பு மேம்படுத்தும் 
ப�ோதும் புதிய மென்பொருள் நிறுவும் ப�ோதும் இந்த 
விருப்பம் பயன்படும்).

•	 Sleep
	 குறைந்த மின் சக்தியில் கணிப்பொறி 
இயக்க இந்த நிலை பயன்படும். இந்த நிலையில் 
திறந்து வைக்கப்பட்டுள்ள அனைத்து 
பயன்பாடுகளும் இயங்கி க�ொண்டிருக்கும்.

	 சூப்பர் விரைவு மறுத�ொடக்கத்திற்கு 
விண்டோஸ்- யைக் கணினியின் நினைவகத்தில் 
இருந்து திறக்கும்.

•	 Hibernate
	 குறைந்த சக்தியில் கணிப்பொறி இருக்கும் 
ப�ோது எல்லா இயங்கும் நிரல்களும் விரைவு 
மறுத�ொடக்கத்திற்கு கணினியின் வன்வட்டில் 
விண்டோஸைத் திறக்கும்.

செயல்பாடு

மாணவர் செயல்பாடு
1. �விண்டோஸ்  இயக்கமைப்பில் க�ோப்பு மற்றும் 

க�ோப்புைறகளை உருவாக்கி ஒப்பிடவும்.

2. �விண்டோஸ் 7, விண்டோஸ் 8 மற்றும் 
விண்டோஸ் 10 இல் ஒரு க�ோப்பு / க�ோப்புரையை 

உருவாக்கவும். அதே நேரத்தில் நீங்கள் 
எதிர்கொள்ளும் வேறுபாடுகள் குறித்த 
அறிக்கையைத் தயாரிக்கவும்.

மதிப்பாய்வு

பகுதி – அ

சரியான விடையைத் 
தேர்ந்தெடுத்து எழுதுக

1.	 கீ ழே  
க �ொ  டு க ்கப்பட்    டு ள்ள  வ ற் று ள்  
இயக்க அமைப்பு  நிர்வகிக்கும் 
செயல்களைத் தேர்வு செய்யவும்

	 (அ) நினைவகம்   	 (ஆ) செயலி	
(இ) I/O சாதனங்கள்		  (ஈ) இவை 
அனைத்தும்

2.	 விண்டோஸ் பயன்பாட்டில்  க�ோப்புகள் 
க�ொடாநிலையாக எந்த க�ோப்புைறயில் 
சேமிக்கப்படும்?

	 (அ) My document
	 (ஆ) My Picture
	 (இ) Document and settings
	 (ஈ) My Computer
3.	� எந்த இயக்கமைப்பில் shift + delete என்ற 

தேர்வு க�ோப்பு மற்றும் க�ோப்புைறயை 
நிரந்தரமாக நீக்கும்?

	 (அ) windows 7
	 (ஆ) windows 8
	 (இ) windows 10
	 (ஈ) இவற்றில் ஏதும் இல்லை
4.	� Windows XP/Windows 7 ல் 

“ஹைபர்னேட்”என்பதன் ப�ொருள் என்ன?

	� அ) Safe modeல் கணினியை 
மறுத�ொடக்கம் செய்தல்.

	� ஆ) hibernate modeல் கணினியை 
நிறுத்துதல்.

	� இ) இயக்கத்தில் இருக்கும் 
பயன்பாடுகளை நிறுத்திய பிறகு 
கணினியை நிறுத்துதல்.

	� ஈ) இயக்கத்தில் இருக்கும் பயன்பாடுகளை 
நிறுத்தாமல் கணினியை நிறுத்துதல்.

5.	� சாளரங்களில் ஒரு க�ோப்பின் மறுபெயரிட 
பயன்படுத்தப்படும் குறுக்குவழி விசை

	 (அ) F2		  (ஆ) F4
	 (இ) F5		  (ஈ) F6
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பகுதி – ஆ

குறுவினாக்கள்

1.	 பல்பணியாக்கம் என்றால் என்ன ?

2.	செ ந்தர பணிக்குறி என்றால் என்ன ?

3.	க� ோப்பு மற்றும் க�ோப்புைறக்கு உள்ள வித்தியாசங்கள் யாவை?

4.	 Save மற்றும் Save As-க்கு உள்ள வித்தியாசங்கள் யாவை?

5.	 ஒரு க�ோப்பை எவ்வாறு மறுபெயரிடுவீர்கள்?

பகுதி – இ

சிறுவினாக்கள்

1.	� விண்டோஸ் இயக்க அமைப்பின் செயல்பாடுகள் யாவை?

2.	� மறுசுழற்சி பெட்டியை பற்றி ஒரு குறிப்பு வரைக.

3.	 விண்டோஸ் சன்னல் திரைக் கூறுகளைப் பற்றி குறிப்பு வரைக.

4.	 ஒரு க�ோப்புரையை உருவாக்கும் இரண்டு வழிமுறைகளை  எழுதுக.

5.	 வெட்டுதல் மற்றும் நகலெடுத்தல்- க்குப் உள்ளவேறுபாடுகள் யாவை?

பகுதி – ஈ

நெடுவினாக்கள்

1.	� விண்டோஸ் இயக்க அமைப்பின் பலவகையான பதிப்புகளை விவரி.

2.	� ஒரு க�ோப்பு அல்லது க�ோப்புரையை தேடிக் கண்டுபிடிக்கும் பல்வேறு வழிமுறைகளை விளக்குக. 

3.	� விண்டோஸ் இயக்க அமைப்பில் குருக்கு வழி பணிக்குறிகளை உருவாக்கும் செயல் முறையை 
விளக்குக-ல் குறுக்குவழியை உருவாக்க செயல்முறை எழுதவும்.

ச�ொற்களஞ்சியம்

இயக்க அமைப்பு
அமைப்பு மென்பொருளானது பிற மென்பொருளுடன் 

த�ொடர்புக�ொள்வதற்கும் மற்றும் வன்பொருள்களைச் செயல்படுத்துகிறது

சுட்டி
ஒரு GUI - இல் ஒரு சுட்டியைக் கட்டுப்படுத்துகின்ற கையுறை வன்பொருள், 

உள்ளீடு சாதனம் மற்றும் உரை குறும்படங்கள், க�ோப்புகள் மற்றும் 

க�ோப்புறைகள் ஆகியவற்றை நகர்த்தவும், தேர்ந்தெடுக்கவும் முடியும்.

விண்டோஸ் மைக்ரோசாப்ட் நிறுவனம் உருவாக்கிய பிரபலமான இயக்க அமைப்பு.

திரைமுகப்பு விண்டோஸ் இயக்க அமைப்பின் முகப்புதிரை

குறும்படம் ஒரு கட்டளையைக் குறிக்கும் சிறிய படம்

க�ோப்புைற க�ோப்புகளை உள்ளடக்கிய க�ொள்கலன்

லினக்ஸ் ஒரு இயக்க அமைப்பு
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